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Welcome to CDM+ 8.1
Congratulations! Your church’s computer software is about to take a giant step forward. Here are the steps involved in moving 
to CDM+ 8.1 from an earlier version of CDM+. NOTE: Although we refer to CDM+ 7.1.2 in this document, it is not necessary 
to update to 7.1.2 before you upgrade to CDM+. The CDM+ conversion routine can convert a datafile as old as CDM+ 4.0. 

If you run into any difficulties during the installation/conversion process, call CDM+ Tech Support at 800-633-9581 Monday-
Thursday 8:30 AM–7:00 PM, Friday 8:30 AM–5:00 PM Eastern Time. Or, you may e-mail us at support@cdmplus.com at any time.

This document will help you install CDM+ and convert your data  from a previous version. After you have upgraded to CDM+, 
be sure to read the “Getting Started”  and “Common Features” documents found in the Manuals folder on the program CD or, 
once CDM+ is up and running, by selecting Browse Manuals under the Support menu. To view the CDM+ Manuals you will 
need Adobe® Reader® (6.0 or later) or another program capable of rendering PDF files. If you cannot view the CDM+ Manuals, 
first check that you have Adobe Reader 6.0 or later installed on your computer. Earlier versions of Adobe Reader cannot open the 
manuals. An installer for Adobe Reader may be downloaded free from www.adobe.com (click on “Get Adobe Reader”).

System Requirements
Please Note!  If you are running CDM+ 8.1 on a stand-alone Macintosh or Windows computer, it is considered the database 
server. System requirements are as follows:

Macintosh (Server & Client Computers) Windows (Server & Client Computers)

Mac OS X 10.4 or later (servers may also run Linux—
kernel 2.6 or later recommended)

Windows 2000/XP/2003/Vista (XP or Vista recommended)

512 MB of RAM 512 MB of RAM

200 MB of disk space + free space for data 200 MB of disk space + free space for data

TCP/IP network connection (static TCP/IP if server) TCP/IP network connection (static TCP/IP if server)

Color monitor running 800x600 or larger (not necessary 
for server not used as workstation)

Color monitor running 800x600 or larger (not necessary 
for server not used as workstation)

NOTE:  On Intel-based Macintoshes, CDM+ 8.1.2 runs under the Rosetta compatibility environment. The Rosetta feature of 
Mac OS X is automatic and does not require you to make any change to run software under Rosetta. On computers running 
Windows Vista®, CDM+ 8.1.2 must run in XP compatibility mode. Special instructions for this are included with your program 
CD and are also found on page 5 of this document.

NOTE:  The conversion routine relies on a component that must run under the Classic compatibility environment. If you have 
an Intel-based Macintosh, are running Mac OS X 10.5 Leopard or do not have Classic installed, please contact CDM+ Support 
to schedule conversion of your data at no charge.

CDM+ will operate natively on a cross-platform network with no additional software required (except the purchase of both 
Windows and Macintosh licenses for CDM+ is necessary). A file sharing connection to the server or between workstations is not 
required. 

CDM+
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General Installation Info
NOTE:  These instructions are written for a multi-user, networked environment. If you only use CDM+ on one computer, that 
computer is considered both the client and the server. Ignore any instructions regarding additional client computers.

Important note for those running CDM+ over a network:
The first computer on which you install and run CDM+ 8.1 MUST be your database server. You may install CDM+ on other cli-
ents while the server completes installation, but do not launch CDM+ on any client until the server displays the Login window.

Firewalls
If you run a firewall on your server, you need to add some exceptions to allow other users to access your CDM+ database. DO 
THIS BEFORE RUNNING CDM+ FOR THE FIRST TIME. The following instructions show you how to do this with Mac OS X’s 
built-in firewall and Windows. For other firewalls, make sure to allow access on ports 20221-20300 or to the programs listed 
below for the Windows firewall. If you do not run a firewall, you can skip these steps.

Mac OS X
1)	 From the Apple Menu, select Location, then Network 

Preferences....	  

2)	 From the View menu in System Preferences, select Sharing.	
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3)	 Click the Firewall tab. If your firewall is turned on, you will see 
the text “Firewall On”. If you see “Firewall Off”, you can skip 
these instructions. If your firewall is running, click New....	  

4)	 Next to Port Name, select Other. For the Port Number, Range 
or Series, enter 20221-20300 (TCP only for Mac OS X 10.4). 
For Description, enter CDM+. Click OK, and quit System 
Preferences.	  

Windows (or other 3rd party firewalls, such as Norton or Zone Alarm)
If you run a firewall on this computer, you will need to make one of these two changes:

1)	 Open ports 20221-20300
2)	 Allow access to these programs (Note: these programs can alternatively be on the D, E, F, G or H drive):
	 •	 C:\OpenBase\bin\openinfo.exe
	 •	 C:\OpenBase\bin\openexec.exe
	 •	 C:\OpenBase\bin\OpenBase.exe

If you choose option 2, you will need to temporarily disable your firewall, install CDM+, and once the program begins the 
update of your database (see below), add access to the three programs listed above and start the firewall.

Consult the documentation on your firewall for how to open ports or allow access for specific programs. For the standard 
Windows Firewall in Windows XP Service Pack 2, visit this web page:  http://support.microsoft.com/kb/875357#7

Upgrading from CDM+ 4.x – 7.1.2 (CDM Plus)
System Requirements
Please Note!  System requirements have changed for CDM+ 8.1 and there are a different set of system requirements for the 
server and client computers (use the server requirements if running 8.1 on a stand-alone Macintosh or Windows computer). 
Please compare your system with the chart on page 1 BEFORE installing the upgrade.
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FIRST - Determine your current CDM+ serial number.
Users of ANY version of CDM+ (or CDM Plus) prior to CDM+ 8.1 must call CDM+ at 877-891-4236 and give us their current 
serial number before beginning the updating process. This serial number must be obtained from within the CDM+ program. 
Please do not read it off a box or label. 

If you have already received a CDM+ 8.1.2 Activation Code, skip to the SECOND section on determing the locaton of your 
CDM+ datafile.

Users of CDM+ 7.x or earlier: 
Go to File > About CDM+ (Windows users) or CDM+ > 
About CDM+ (Macintosh users). The “About CDM+” window 
appears.

Users of CDM Plus (your program icon has a purple 
“plus” across it):
Go to File > About CDM Plus (Windows users) or CDM Plus 
> About CDM Plus (Macintosh users). The “About CDM Plus” 
window appears.

Carefully record the serial number (including any dashes) you see on the window.

Call 877-891-4236 to report your current CDM+ serial number. You will be asked for an e-mail address to which we can send 
your CDM+ 8.1.2 activation code and instructions. Creating a new activation code is not an instantaneous process, so you can 
expect to receive the e-mail within 2 business days (often sooner).

Once you receive your CDM+ 8.1.2 Activation Code you may proceed to the section on installation below.

SECOND - Determine the location of your current CDM+ datafile
You will need to know this during the conversion process. The path to this datafile can be found in CDM+ 7.1.2 (or CDM Plus) 
by going to File>System Information, and checking the datafile location. 
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If you own the Event Registration program, you will need to know the location of that datafile also. This file (regdata.df1) is 
normally in the same location as the regular CDM+ datafile, and you can verify its location in CDM+ 7.1.2 by going to Event 
Registration, and going to Registration>About Registration and clicking Info.

	 	

Make a note of the location of your datafile(s).

IMPORTANT:  Before quitting your current version of CDM+, you should check to see that Passwords are set up for each user 
as you desire under Password Maintenance (File menu->Change User Password/Preferences) and make note of those 
usernames and passwords. The conversion process will carry them forward to CDM+. For information on maintaining pass-
words in CDM+, see the User Management section of the Administrative Tools manual.

Quit your current version of CDM+ before starting the CDM+ 8.1 
installation/conversion process.

Firewalls – If you run a firewall on your server, please read the section regarding firewalls on page 2 BEFORE installing the 
CDM+ 8.1 upgrade on your server.

THIRD - Install CDM+ 8.1.2 on EVERY computer than runs CDM+
1)   If you did not choose to order the CDM+ 8.1.2 update on CD, you will need to download the installer. Follow the 

instructions you received via e-mail.

2)    Following the instructions e-mailed to you or included with your CD, INSTALL BUT DO NOT OPEN CDM+ 8.1.2 on 
EACH computer that needs to use it. 

Important note for those running CDM+ over a network:
The first computer on which you install and run CDM+ 8.1 MUST be your server. Also, you MUST let the initial conversion to 
8.1 complete before launching CDM+ on any additional client computers. You may install CDM+ on other clients while the 
server updates your data, but do not launch 8.1 on any client until the server displays the Login window.

Macintosh
1)	 Insert the CDM+ program CD in the CD/DVD drive of the computer where you wish to store your data (the CDM+ 

server). This may be the only computer on which you are installing CDM+. But if you are installing CDM+ on more than 
one computer on your network, you MUST begin with the server.

2)	 Locate the CDM+ CD icon on your desktop and double-click it. 

3)	 Double-click the CDM+ Installer icon.

4)	 Follow the on-screen instructions.

After the installation process finishes, you can launch CDM+ by double-clicking the CDM+ application located in the CDM+ 
Folder that was installed. The default installation location is Applications/CDM+.
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Windows
1) 	 Insert the CDM+ program CD in the CD/DVD drive of the computer where you wish to store your data (the CDM+ 

server). This may be the only computer on which you are installing CDM+. But if you are installing CDM+ on more than 
one computer on your network, you MUST begin with the server.

	 Once you insert the CDM+ program CD in your drive, the installer should automatically open.  Follow the on-screen 
instructions to install CDM+. If the installer does not open, follow the steps below.

2)	 On your desktop, double-click My Computer. If you do not see My Computer on your desktop, click Start and then 
My Computer.

3)	 Double-click the CDM+ CD icon.

4)	 If the installer doesn’t begin, double-click the CDM+ Installer.exe icon (this may appear as CDM+ Installer).

5)	 Follow the on-screen instructions.

VISTA USERS ONLY:

6)	 Before opening CDM+, right-click the CDM+ shortcut on your desk-
top and choose Properties.

7)	 Select the Compatibility tab.

8)	 Check “Run this program in compatibility mode for:” and select 
“Windows XP (Service Pack 2)”.

9) 	 Check “Run this program as an administrator”.

	 NOTE:  If this option is grayed-out and you cannot check it, you 
need to enable User Access Control (UAC). Consult the Vista Help 
for steps on enabling UAC or contact CDM+ technical support 
(800-633-9581). Once you check “Run this program as an adminis-
trator”, you can disable UAC again.

10) 	Click OK.

11)  Right-click the CDM+ shortcut on your desktop and choose “Open 
File Location”.

12)  Open the folder “conversion”.

13)  Right-click “Conversion.exe” and choose properties. Follow steps 7-9 above and click OK.

14)  CDM+ and the 7.1.2 conversion process will now function properly under Windows Vista. After the installation pro-
cess finishes, you can launch CDM+ by double-clicking the CDM+ shortcut on the desktop or the CDM+ application 
located in the CDM+ Folder that was installed. The default installation location is:

	 C:\Program Files\CDM+
	 (or Start->Programs->CDM+->CDM+)

If you experience difficulties while installing CDM+, call the CDM+ Technical Support staff at 800-633-9581 Monday-
Thursday, 8:30 AM–7:00 PM, Friday 8:30 AM–5:00 PM Eastern Time for assistance.



8

Server Setup
Follow these instructions even if you are installing CDM+ 8.1 on only one computer.

If you only use CDM+ on one computer, that computer is considered both the server (the computer that has your data on it) 
and the client. You can ignore any instructions regarding additional client computers.

Macintosh – CDM+ 8.1 operates under Mac OS X 10.4 or later. You may also install it on a server  running Linux (kernel 2.6 or 
later recommended), however, clients computers may not be running Linux. 

Windows – CDM+ 8.1 operates under Windows 2000, 2003, XP and Vista. We recommend Windows XP or Vista for all Windows 
users. CDM+ will run in XP compatibility mode under Vista. If you are running Vista be certain to note the special instructions 
regarding Vista above. 

These instructions will document setting up CDM+ 8.1 under Windows XP and Mac OS X 10.4, so you may see some slight dif-
ferences between the screenshots and your operating system.

For either Windows or Macintosh:

1)	 Begin by installing and launching CDM+ 8.1 on your server. See the Installation Instructions available for download 
from the CDM+ website or on the CDM+ upgrade CD for more information.

2)	 The welcome screen will appear. Click Continue.

NOTE:  For help during the setup process, click on the Help 
button on any window to open a pop-up window:

3)	 CDM+ will ask how you’d like to configure CDM+. Choose the 
3rd option (that you are updating from an older version of 
CDM+ prior to 8.1) and click Continue. 
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4)	 Next choose a Database Server Option. You may click each of 
the radio button to see more information about each option.

Local Database Server
If you will be using CDM+ on this computer ONLY, choose the 
first option “Install a local database server”. Click Continue.

Network Database Server
If you will be using CDM+ on more than one computer on your 
network, first be certain that this computer is where you want 
to install the database server. If you are not certain, STOP. 
CDM+ must be installed FIRST on the database server. If this 
is not the correct computer, click Quit CDM+ and first install 
CDM+ on the database server computer before installing on 
this computer.

If this is the computer that will be your CDM+ database server,  
choose the second option “Install a network database server”. 
Click Continue.

CDM+ Data Hosting Service
If you purchased the CDM+ Data Hosting Service, choose the 
third option “Use CDM+ Data Hosting or a remote server”. Click 
Continue.

Enter the User ID and Data Hosting Password given to you 
by CDM+ and click Continue. Your CDM+ database will be 
installed on a CDM+ Hosting Server. 

If you are not sure of which Database Server Option to choose, 
contact CDM+ Technical Support for help. Call 800-633-9581 
Monday-Thursday 8:30 AM-7:00 PM, Friday 8:30 AM-5:00 PM 
Eastern time.

5)     Select the radio button next to “Version 7.1.2 or earlier” and 
click Continue.
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Set up the Conversion from CDM+ 4.x – 7.1.2 (CDM Plus)
1)	 This opens the first of the Conversion Assistant screens. 

	

2)	 Click Next.

	

	 The Conversion Introduction window explains the steps of the conversion process. After reading them, click Next.

	

3)	 Select Datafile – Next, you are prompted to select your existing CDM+ datafile. CDM+ will ask if you want to scan 
your entire hard drive for valid CDM+ datafiles.

	 If you click YES, this could take a long time. Since you already took note of the location of your CDM+ datafile, you 
can click NO and click on the Scan Folder for Datafiles button. This will allow you to browse your computer for the 
folder holding your CDM+ datafile, select the folder, and click Open.  CDM+ will list all valid datafiles it finds in the 
window. 

	 Once you have the correct datafile highlighted, click Next.
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4)	 Copy Datafile – Next, the 
Conversion Assistant will copy your 
datafile to your local hard drive (or 
any location you specify) and work 
off this copy.

	 NOTE: This cannot happen if you 
have your current of CDM+ open on 
your computer.

	 The conversion assistant works on a copy of your current CDM+ datafile to avoid disrupting your current CDM+ 
setup. This means is that if the conversion does not complete, your current copy of CDM+ will be untouched. Also, 
you can continue to work with the current copy of CDM+ while the conversion runs (after it’s copied in this step), 
though any changes you make to your current copy of CDM+ will not be in the converted data.

	 Confirm that the Copy to: location is correct. If you wish to select a different location, click on the Browse button. 
Click Next.

Conversion Options
5)	 Next you will be asked to set several settings, which are organized into tabs under Step 5 of the Conversion Assistant. 

Depending on the CDM+ programs (modules) you own, you may not see them all.  Click on each tab of this window, 
making selections as prompted.

	

Membership tab

	 CDM+ contains a new field on the Address Records window called Care Group. You have the option to rename this 
field in CDM+, but it is designed to allow you classify addresses/families into care groups, elder groups, shepherd-
ing groups, etc. During the conversion process you have the option to choose Geographic Codes to convert to Care 
Groups. Geographic Codes that are not converted to Care Groups will remain listed as Geographic Codes in CDM+.

	 NOTE: If you choose to not select any Geographical Codes to be converted to Care Group codes during the conver-
sion, you can later use Address List Maintenance to move existing groups on the Groups tab of Address Records to 
Care Groups.  

	 Click on the Giving History tab of the Converstion Options window.
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Giving History tab

	 While previous versions of CDM+ support up to five years of giving or contributions history, CDM+ supports an unlim-
ited number of periods. In order to correctly convert your existing history, the conversion assistant need to know the 
date ranges of your existing history. This is particularly relevant if your history operates on a fiscal year, rather than a 
calendar year. If you still have the detailed contribution records in your datafile, you can redo the history in CDM+ after 
the conversion completes.

	 Click on the Payroll tab of the Conversion Options window.

Payroll

	 Payroll in CDM+ supports two local 
tax codes, for example a county 
and city. Under the Payroll tab of 
the conversion options, you can 
select a User Deduction from your 
current version of CDM+ to convert 
to a secondary local tax.

	 Click on the Address Mailings tab of the Conversion Options window.
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Address Mailings

	 To simplify mailing newsletters and directories, CDM+ contains Newsletter and Directory checkboxes on the Address 
Records window. You can have these boxes checked during the conversion process by specifying certain mailing codes 
or using thethe Receives Tape and Receives Video checkboxes settings in your current version of CDM+.

	 Once this is done, you may quickly print labels or envelopes for this group of addresses just by making a selection on 
the report setup window, rather than specifying several mailing codes.

	 NOTE: Selecting Address Records with certain Mailing Codes to be marked with a Newsletter or Directory checkbox 
for quick printing of labels or envelopes does not affect the existing mailing codes assignments at all.

	 Click Next. 

	

Optional Files
	 If you own CDM+ Event Registration, you will be prompted to select your Event Registration datafile, named “regdata.

df1”. This file is normally in the same location as the regular CDM+ datafile. If you do not see it listed on the window, 
click on the Scan Folder for Datafiles button. This prompts you to select a folder to scan for valid CDM+ datafiles 
and lists them in the window. Since you took note of the location of your CDM+ Event Registration datafile before 
starting the installation/conversion process, you should have no trouble selecting it here. Once you have the correct 
datafile highlighted, click Next.

Allow CDM+ to convert your data
At this point, the conversion process will begin. First, the conversion assistant will bring your previous datafile up-to-date with 
the most current version of CDM+ 7.1.2 .

NOTE: Before clicking Start Conversion, write down the IP address (192.168.1.123 in the example below) on this window. You 
will need it later.



14

You will be asked (twice, if you own Event Registration) if you want to convert the copy of your datafile—click Yes to each 
message. (Remember—this conversion is being done on a copy of your current datafile. You will still be able to access the 
orginial with your current version of CDM+.)

The conversion will now run unattended until it is complete.

During the conversion process, a log file is written in the CDM+ program folder detailing the conversion’s progress. Once the 
conversion is complete, you can view  this log file in the conversion assistant window.  You may also Save or Print the conver-
sion log by clicking on the appropriate button on this window.

NOTE: Providing you don’t delete your previous datafile, everything in your old version of CDM+ will still be available. If fact, you 
could even reconvert your old data if you wanted. You may wish to run duplicate programs for a short period while learning the 
new features of CDM+. When you are confident in using only the new program, you would then re-convert the datafile.
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Launch and Activate CDM+ 8.1
Click on the Start CDM+ button at the bottom of the final 
Conversion Assistant window.  The Login window opens.

Carefully type (or copy and paste if supplied in an e-mail) the 
Activation Code given to you when you upgraded to CDM+ 
8.1 and click Continue.

NOTE: CDM+ will keep its version synchronized with the latest available version on your network. This means that adding an 
additional computer at a later date can be done easily from the original CD—the first time you connect the new machine to 
your database, the latest version of the program will be installed.

Client Setup - Upgrading from CDM+ 4.x - 7.1.2 (CDM Plus)
1)	 Begin by installing and launching CDM+ 8.1 on the client computer. See the Installation Instructions available for 

download from the CDM+ website or on the CDM+ upgrade CD for more information.

2)	 The welcome screen for 8.1 will appear. Click 
Continue.
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3)	 CDM+ will ask how you’d like to configure CDM+. 
Choose the 2nd option (that CDM+ 8.1 is already 
installed on your server) and click Continue. 

4)	 CDM+ will ask for the address of the server. Enter 
the address you noted in step 4 above and click 
Continue.

5)	 Select your user (or enter your username), enter your 
password and click Log In.
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Changing Your Password
If you wish to change your password, click Change Password on the Login win-
dow. Enter your current password, the new password you wish to use (confirming 
that password by re-entering), and click OK.

If you have lost your password, ask your system administrator to give you a new 
one. If you are the system administrator and have lost your password, contact 
CDM+ Technical Support for help resetting your password. See the Support sec-
tion below for information on contacting Tech Support.

Welcome to CDM+ Window	
After setting up CDM+ and logging into it, you will be present-
ed with the Welcome to CDM+ window.  There is a button for 
each program and sub-program of CDM+ here.

You may check the box at the bottom next to Don’t Show This 
Window at Startup to avoid seeing it again. To re-enable this 
window at any time, choose Open the application Welcome 
window from the Startup options of the General Preferences 
window. See the Preferences section in the Administrative 
Tools chapter of the CDM+ manual for more information on 
setting and changing preferences.

To view this window at any time, select Welcome to CDM+ 
Window from the Support menu.
Click on one of the buttons to see a list of steps to begin using 
that program or sub-program. 

Click on the Windows tab to open a new pane. Clicking on one 
of the buttons found here will open that record window.

Click on the Reports tab to open another pane, listing the re-
ports within this particular program or sub-program. Double-
click on the desired report name to open the report setup 
window.

See the Getting Started with CDM+ and Common Features manuals for more information about navigating CDM+. See 
below for how to access the CDM+ electronic manuals.

Accessing the CDM+ Manual
The CDM+ Manual is available electronically in Adobe PDF format either from within CDM+ or directly from the CDM+ pro-
gram CD.  This enables us to easily update the manuals as changes are made to the software.  You will be notified by e-mail if a 
major update to the manual is released.

To view (and print, if desired) the CDM+ manual from the program CD, open the Manuals folder and double-click on the 
desired topic.

Note: Windows users will need to right-click the CDM+ CD icon, choose Explore, and click on the Manuals folder. Double-
clicking the CDM+ CD icon will launch the program setup.
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To view (and print, if desired) the CDM+ manual from within 
the program, select Browse Manuals from the Support 
menu. Double-click on the desired topic to open it.

We suggest you first read 1-Getting Started and A-Common 
Features which will introduce you to the fundamentals of 
CDM+. The 0-Using CDM+ Help document has instructions 
in using CDM+ manuals.

NOTE: You need to have Adobe Reader® or another program 
that can render PDF files installed. If you are having problems 
opening the CDM+ manuals, first try installing the latest 
version of Adobe Reader for your operating system. You can 
download the free Reader software from www.adobe.com 
(click on “Get Adobe Reader”).

If you are unfamiliar with Reader, we suggest you spend a few minutes with Reader Help (found under the Help menu when 
viewing a manual) to learn how to view, navigate and print PDF documents.

You may print as many copies of the CDM+ Manual sections as you’d like and put them in a binder, if you desire. 

Getting Help with CDM+
Phoning CDM+ Tech Support
Help from CDM+ Technical Support staff is available by calling 800-633-9581 Monday-Thursday, 8:30 AM–7:00 PM, Friday, 8:30 
AM–5:00 PM Eastern Time for assistance. (Note: Kentucky does observe Daylight Saving Time.) 60 days of free access to our 
toll-free phone support, beginning on the purchase date, is included in the upgrade price of CDM+. Please do not hesitate to 
call; we are happy to help.

If no tech support personnel are available when you call, you will be placed on a callback list. Tech support calls are returned 
in the order in which they are received. Our commitment is to return all support calls within four hours of the time we receive 
them, but we usually respond in half that time or less. Certain times are busier, such as January or when we release a new version 
of CDM+ , and we appreciate your patience when the call load is heavy. 

If you call outside the above hours, or if all operators are busy when you call, please leave a voice mail message with your 
name, your church or organization name, location and phone number. It is not necessary to explain your support issue in de-
tail. If CDM+ Tech Support is not open when you call, you will be called when we are next open. If you reach the Tech Support 
voice mail during regular support hours, you will be placed on the list for a return call.

If we do need to call you back and you know you will be unavailable at a certain time, it is helpful to give that information to 
the operator when you phone to avoid missing our return call. For example, if you tell us you’ll be out to lunch between Noon 
and 1 PM CST, we won’t call you back during that time period.

Support Menu
The Support menu provides access to user support for CDM+, including the electronic manual, links to the Tech Support e-
mail address and CDM+ website, and a form for providing feedback on the program.

Browse Help Manuals
Select this menu item open the Browse Manuals window. See the Accessing the CDM+ Manual section above.

E-Mail Tech Support
If you need CDM+ technical support, you can call toll-free 800-633-9581 (Mon.-Thurs. 8:30 AM–7:00 PM, Fri. 8:30 AM–5:00 PM 
Eastern Time). 
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You can also e-mail us your question. Select E-Mail Tech Support under the Support menu to open a new e-mail to support@
cdmplus.com with your e-mail application.

Be sure to include your name and the church name and location (you’d be surprised how many churches have the same name!) 
in the body of the e-mail. We cannot respond to your questions if we cannot find you in our database of churches and organiza-
tions using CDM+. Also, please add support@cdmplus.com to your e-mail application’s address book or “allowed” list to avoid 
missing e-mails from CDM+ support staff due to spam-blocking software.

Tech Support phone calls generally take precedence over Tech Support e-mails. Therefore, during busy support times, such as 
when a new version of CDM+ is released or in January, you may experience a slower response time to e-mails.

Welcome to CDM+ Window
Select this menu item to open the Welcome to CDM+ window (described above).

Provide CDM+ Feedback
If you need to report a bug, want to make a sug-
gestion or provide any other type of feedback, you 
can select Provide CDM+ Feedback under the 
Support menu to access the feedback form. 

To use the Provide CDM+ Feedback feature,  just 
fill out the form, making sure to include a detailed 
description of your feedback, and click Send. You 
may also include pertinent screenshots of open 
windows by checking them in the Include screen-
shots list.

Please note:  The Provide CDM+ Feedback function 
does not take the place of contacting CDM+ Tech 
Support. You will not get a response from the CDM+ 
software developer working on the issue unless he or 
she has a question. For timely help with a problem, 
please call or e-mail CDM+ Tech Support.

CDM+ Training Opportunities
A variety of training venues are available to CDM+ users. For more information on CDM+ Training, visit our website (www.
cdmplus.com).

On-Site Training
For the ultimate in personalized individual training, we offer on-site training. You can arrange to have a CDM+ trainer come to 
your office at a mutually agreeable time to work with you and your CDM+ database. Contact us by phone (800-633-9581) or 
by e-mail (training@cdmplus.com) to discuss an on-site visit. 

Annual CDM+ Users Conference
The annual users conference is our premier group training experience. Over 3 days you can choose from over 30 classes cover-
ing all aspects of CDM+. Classes are offered for both the novice user and experienced users who want to explore how CDM+ 
can further impact their ministry. Plus, the CDM+ Tech Support staff and program developers are available on-site in labs to 
answer your questions. The conference is a great chance to network with other CDM+ users from all over the country. Visit our 
website, www.cdmplus.com, for more information. 

Regional Training Events
Periodically, we offer lecture-style, classroom training events around the country. During these two-day seminars, our trainer 
follows a set course of basic instruction in the use of CDM+. One day is devoted to Membership, Attendance, Visitor Records 
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and Event Registration training and the second day we cover Contributions, Memorial Gifts, and Accounting (General Ledger, 
Accounts Payable, Account Receivable, and Payroll). Regional Training Events are publicized on our website and in our news-
letter. You will be notified by e-mail when an event is coming to your area.

Online Training Options
Using a high-speed Internet connection on your own computer and a phone, you will be able to see and hear as a CDM+ 
trainer illustrates working in CDM+. 

Online Group Training
A small group (10-12 clients) training class hosted online by an experienced trainer, Online Group Training focuses on the daily 
and weekly ministry tasks that you perform in your ministry roles. Each one-hour class features both lecture and Q & A teach-
ing styles. A variety of classes are available for each CDM+ program in both basic and advanced levels. A FREE Fundamentals 
of CDM+ class is offered periodically and all CDM+ users are encouraged to take it.

Online Individual Training
This training is also hosted online but caters to the training needs of one client.  The content and length of the session will be 
agreed upon in advance by the client and the trainer after assessing the client’s needs. Sessions feature consultation, lecture 
and/or Q & A teaching styles and are available for each CDM+ program or a combination of programs, or as an opportunity to 
consult about using CDM+ to support the unique ministry of your organization. This individualized training approach allows 
the client to get precisely the training/consultation needed. 

CDM+ Premier Support Program
Most CDM+ users find it worthwhile to enroll in the optional annual CDM+ Premier Support Program. Although you may get 
a good start with CDM+ during the free 60 days of support after purchasing the upgrade to CDM+ 8.1, it is good to know that 
the friendly, helpful CDM+ Tech Support staff is there to help out anytime as you delve into the possibilities CDM+ brings to 
your ministry.

Benefits of the CDM+ Premier Support Program include:
•	 UNLIMITED toll-free phone support
•	 E-mail support (with preferential response)
•	 FREE CDM+ updates and minor upgrades (downloaded)
•	 Discounts on training, including the annual CDM+ Users Conference
•	 Discounts on 3rd-party products, such as check readers, barcode scanners, specialty printers and PhoneTree®
•	 Discounts on CASS certification for automation rate mailing
•	 FREE federal and state payroll tax table updates as needed (downloaded)
•	 TRAINING CREDITS – For each CDM+ program owned, Premier Support members earn one training credit each year. 

Credits may be combined and applied to any type of training listed above.

Please note: If you choose not to enroll in the CDM+ Premier Support program, and you call for CDM+ technical support after 
your initial 60 days (from date of upgrade purchase) of free support, you will be charged $55/instance. If the problem exists 
due to a program error, there will be no charge.

CDM+ Annual CD Maintenance Program
All updates  and minor upgrades to CDM+ are free to members of the CDM+ Premier Support program as a download from 
our website. If you choose to get an update mailed to you on a CD, there is a $10 charge.

As a convenience for our users who are unable to download updates, we offer the CDM+ Annual CD Maintenance Program. 
For $36/year, you will automatically receive in the mail all published update releases of CDM+ (including tax tables).  You must 
be enrolled in the Premier Support Program to participate in the Annual CD Maintenance Program.

To enroll in the CDM+ Premier Support and Annual CD Maintenance Programs, please call the CDM+ Sales 
Department at 877-981-4236 Monday–Friday 8:30 AM–5:00 PM Eastern Time.
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